
Customizing Co:Writer for Individual Students

The File menu lets you change writer files, start new writer files, hide the Co: Writer 
Window and print dictionaries.

Writer files are where Co: Writer keeps detailed information and personal preferences of 
individual writers.  Once a Writer file has been created and set - up for a particular student,  
that file should be saved for that student so that his individual needs and preferences are being 
met each time he/she uses Co: Writer.

The size and placement of the Co:Writer Window and the display of predicted words 
within the Co:Writer Window are easily customized for individual student needs and 
preferences. Easily change how many predicted words appear, where they appear and many 
other factors. Use the Format menu to change how things look in the Co:Writer window. 
These “custom” settings will be automatically saved to that student’s writer file.

• Creating & Saving a New Writer File:

• Select New Writer from the File menu.

• The file collects and saves the new writer’s name, main dictionary, personal dictionary, 
window size, font, and many other preferences.  Once saved, the writer file is placed in 
the Co: Writer folder and used thereafter.

• Use New Writer whenever a new writer begins using Co: Writer.  

• Use the Save Writer As function in the file menu to assign a new name to the current 
file.  The original writer will be unaffected. (This is like duplicating a writer and giving 
the duplicate a new name.)

 

• Customizing the Window Display:

• Resize the Co:Writer Window

• Expand the Co:Writer Window to the maximum width of the screen 
• Size Window to Fit 
• Macintosh zoom box (upper right corner of Co:Writer Window)
• “Pull” the lower right corner of the Co:Writer Window)

• Undo the Expansion
• Revert Window 
• Macintosh zoom box (upper right corner of Co:Writer Window)
• “Pull” the lower right corner of the Co:Writer Window)



• Show Window Title/Hide Window Title

• Plain white window (Hide Window Title)

• Window with title bar, size box and zoom box (Show Window Title)

• Show Numbers/ Hide Numbers

• This option allows you to choose whether or not to show the numbers in the 
predicted words.

• Choosing to hide the numbers may benefit some writers who may have trouble 
distinguising between the numbers and words.

• When the numbers are hidden, words from the list cannot be selected with the 
number keys. Instead, use a mouse pointing device or . 

Tip: When the numbers are hidden you may type numbers in the Co:Writer 
sentence since they no longer select words. This may be a quicker way for some 
writers to type numbers in the sentence.

• Arrangement Options for Word Choices:

• Dynamic vs. Fixed

• With a dynamic arrangement word choices appear in a column directly below 
the word being typed. As you write, the column of word choices moves along 
with the sentence. 

• With a fixed arrangement the word choices are in a horizontal and fixed format. 
The word choices never move. This arrangement may be useful for individuals 
that work better with a left-to-right sequence or when a stable appearance is 
important.

• Double-Spaced Word Choices

• Choosing double-spaced places greater white space between word choices 
which may help some writers with reading word choices. Also, try this option if 
you use a mouse pointing device to make word selections.



Tip: Use the size box to make the Co:Writer Window bigger to see more 
predicted words. If you have hidden the window title (and size box), point to the 
lower right hand corner of the window and hold down the mouse button until 
the window outline appears, and then resize.

• Alphabetical Order

• Co:Writer typically lists word choices in the order in which they are most likely 
to be wanted (word number one is the word Co:Writer thinks is you r most 
likely choice). 

• Choosing Alphabetical Order places the word choices in alphabetical order.

• Repeat Guesses

• Some users bypass their desired predicted word because they type past it and other 
predicted words replace it. With the Repeat Guesses option, predicted words stay in 
the suggested words list as long as they match the letters typed.

• For this example, type the sentence: The book is interesting.

• Co:Writer predicts interesting after one keystroke. 
With Repeat Guesses toggled off, if the user types the second letter of the word, 
Co:Writer responds with new choices. 

• With Repeat Guesses toggled on, Co:Writer keeps previously predicted words that still 
meet the letters typed in the list and moves them closer to the top.

• Predict Ahead & Predict In-Line

• Predict In-Line 

• With Predict In-Line turned off, letters appear in the space where you are typing 
as you type them.

• With Predict In-Line selected, Co:Writer predicts a word in the space where you 
are typing after you type a letter . Press to accept this word. 

Tip: Writers may find that predicted words “popping up” in the middle of their 
sentence to be confusing.



sentence to be confusing.

• Predict Ahead

• When Predict Ahead is selected, Co:Writer predicts words ahead in the sentence. 
As soon as the writer accepts a word, Co:Writer offers a list of word choices. If 
none of the anticipated words are what you want, begin typing the word.

Predict In-Line & Predict Ahead

• When both Predict In-Line & Predict Ahead are selected, Co:Writer offers an in-
line word plus a list of word choices once a writer accepts a word. If none of the 
anticipated words are what you want, begin typing the word.

• Select the Number of Word Choices

• Select the number of word choices you want Co:Writer to predict.

• Select No Numbered Words to have Co:Writer offer a word only in the in-line sentence 
and none below

• The size of the window and the font selected affects the number of word choices 
showing in the Co:Writer Window. When you change the size of the window or the 
font, the number of word choices increases or decreases to fit the new size.

• Select a Main Dictionary

• Select Main Dictionary Size from the Options menu

• The smaller dictionaries are subsets of the largest one.

• A word is included in a particular dictionary based on the frequency score. Each 
word has a frequency score from 0 - 31.

• 2,000-word Dictionary
Words that are used most often in the English language have the highest 
frequency scores and are included in the 2,000- word dictionary. Examples of 
these words are: “the,” “is,” “have,” “of,” “seem,” “like,” “want,” “maybe,” 
“because.”



“because.”

• 10,000-word Dictionary
The next level dictionary has 10,000 words. Those wordshaving high to medium 
frequency scores are included. Examples of these words are: “siphon,” 
“punctual,” “bacteria,” “balmy,” “barbaric.”

• 40,000-word Dictionary
The largest, 40,000-word dictionary includes words with frequency scores down 
to zero. Examples of these words are: “cadence,” “aberrant,” “paella,” 
“Machiavellian,” “refulgent.”

• 0-word Dictionary
Choose the 0-word dictionary when you want Co:Writer to predict only your 
personal or collected words.

• Turn Grammar Off/ Turn Grammar On

• Use this setting to toggle grammar on / off.  This command controls whether grammar 
principles are used in word prediction.

• Use “Grammar Off”  when grammar is not desired for a document (ex:  lists of 
specialized words).  This setting may cause students to write grammatically incorrect 
sentences (lacking nouns, verbs, etc.)

• Use “Grammar On” when grammar principles are needed to complete a document 
(ex:   writing sentences, paragraphs, and stories).

• Collect New Words

• When checked, Co:Writer automatically collects and saves new words as they are typed 
in the Co:Writer Window. New words are any words not contained in the current 
dictionary or the personal dictionary.

• Use to collect unique words such as names and places that will be used again.

Tip: Remember, when this feature is checked, Co:Writer will collect all new words, 
including mispellings, mistakes, and improper words. 

• You can add to and edit the words Co:Writer “collects”.

• Periodically, the collected words should be edited and transferred to the writer’s 
Personal Dictionary (see Working with Dictionaries for more information)

• Select Font & Size

• Fonts selected in this menu change the way word choices and the in-line sentence 
appear in the Co:Writer Window. They do not affect the fonts in the word processor or 
any other application behind the Co:Writer Window.



appear in the Co:Writer Window. They do not affect the fonts in the word processor or 
any other application behind the Co:Writer Window.

• Select the typeface and size to accommodate visual needs and preferences.

• Select Other... to choose additional fonts and sizes.

• Select the cursor type to us in Co:Writer to accommodate visual needs or 
preferences.

• Select Speech Options

• Use the Speech menu to set and use speech output options. All settings are 
automatically saved to the active writer file.

• Turn Speech Off/Turn Speech On

• Select this item to toggle speech on/off

• Select Turn Speech On when speech is desired and students benefit from 
hearing words and sentences read to them

• Select Turn Speech Off when speech is distracting

• Voice Settings

• Select Voice Settings to:  

• Choose a voice

• Adjust the speech rate

• Adjust the volume

• Pronunciations

• Select Pronunciations to add, modify, or delete entries in the Pronunciations 
Exceptions dictionary.

• Use the option to change mispronounced words (ex: abbreviations and irregular 
proper names

• Speech & Scanning Options 



Working With Co:Writer

• Different Ways to Select Words

• Spacebar: 
• Pressing the  accepts a word and inserts it into the sentence.

• Point and click: 
• Move the mouse pointer over the word and click

• Up and down arrow keys:

• Press the  to select the word then press the  to accept 
 

Tip: when you want to select a word at or near the end of the choices, use  
to start the selection box at the bottom of the list.

• Numbers  etc.:

• When the word choices are numbered, type the number of the word you want. 

• Scan Word Choices:

• Press  (Control-U in Windows) and the selection bar moves through the 

list. When the word you want is selected, press . Press Esc to stop the 
scan.

Tip: Press  to stop the scan.
 

• Puntuation

• You can automatically accept a word and place a comma after it by pressing 
. The same is true for the semi-colon and colon.

• When you use the period, question mark or exclamation mark, Co:Writer accepts 
the word, ends the sentence and transfers it to the word processor.

• To type a question mark, simply press . Typing  is not necessary. You 
will need to type  to get an exclamation mark ( ). 



• To type a question mark, simply press . Typing  is not necessary. You 
will need to type  to get an exclamation mark ( ). 

• Oops! How Do I Change That?

• Use the  key to correct letters. It backs up and deletes one character at a 
time.

• Review previous word predictions with . This is useful when you think you may 
have passed by your desired word. (This is not available on the Windows platform).

• To delete your last accepted word or the word you are working on, press This 
deletes the entire word in one step.

• How Do I Get the Word I Really Want?

• Prefixes

• Instead of beginning a word by entering a letter, you may start with a prefix. 
Before starting your word, generate a list of prefixes by typing  
(Mac only) or the  key and the */8 key.

Tip: For one-keystroke access to prefixes, press the asterisk  key on the 
numberic keypad.

• Select the prefix from the choice list. After you select a prefix, continue the 
word by entering a letter. Co:Writer inserts it into the in-line sentence and it 
becomes the first part of the in-line word.

• If the prefix you want is not among the choices, type the first letter. A new 
choice list is displayed. Select a prefix or continue typing it. Accept the prefix 
and continue your word.

Tip: Use the prefix keys as a teaching tool. The lists may help some writers 
understand more about the variety of prefixes available.

• Word Endings

• A word ending can be added to any accepted word. Word endings are 
displayed with the right arrow key .

• When you press the  key, Co:Writer displays a list of appropriate word 
endings. Select the word with the ending you desire.

• Suffixes

• A list of suffixes can be displayed that can be added to the accepted word.



• After accepting a word, generate a list of suffixes by typing  or 
. 

Tip: For one-keystroke access to suffixes, press  on the numeric keypad.

• Select the suffix from the choice list and Co:Writer appends it to your word.

• If the suffix you want is not among the choices, type its first letter. A new 
choice list is displayed. Select a suffix or continue typing it.

• Hyphenated Words

• Type the  where it falls within the word.

• Punctuation Within the Word

• Initials such as “Washington, D.C.” or in a name such as “P. J. Jones” are a 
little more complicated to use because punctuation usually tells Co:Writer to 
end a sentence.

• You may use punctuation within a word by using the command key  
with the punctuation you want. (Use the control key in Windows).

• Typing Number and Other Characters

• Use True Keys Mode

• Start True Keys with the  key. This turns off all of the special 
characteristics of typing with Co:Writer and the keyboard returns to its 
standard function.

• The Co:Writer cursor inverses from you usual setting so you know you are in 
True Keys.

• To go back to regular Co:Writer, stop True Keys by pressing again.

• Dollar and Number Signs

• Co:Writer allows you to type sentences that include dollar signs and number 
signs without switching to True Keys mode. For example:

• This Costs $2.00
• Do Problem #1.

• Quotation Marks

• When you use quotation marks within a sentence, Co:Writer waits for the 
second quotation mark after the period instead of transferring the sentence 
immediately.



• When you use quotation marks within a sentence, Co:Writer waits for the 
second quotation mark after the period instead of transferring the sentence 
immediately.

• When you are finished with the sentence, type Enter to transfer it.


